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Chapter 1

Introduction

1.1 What is Pstress?

PStress is a proprietary program developed at CDI. The first version was created in 1984.
This version used a closed-form analytical method to solve for the stresses in a pulley.
The program was based on the work of H. Lange (1963) and W. Schmoltzi (1974). In
1993 CDI expanded the number of shapes PStress could model by added a relatively
small number of finite elements to the pulley simulation. This allowed us to preserve the
speed of the close-form analytical analysis, while adding the ability to model complex
geometries. Xiangjun Qiu and Vinit Sethi published CDI’s new simulation method (and
comparisons between our method and full ANSYS simulations) in a paper titled A New
Pulley Stress Analysis Method Based on Modified Transfer Matriz. This paper appeared
in Bulk Solids Handling volume 13, issue 4.

PStress V3.2.3 calculates stresses that can be used for fatigue analysis at various loca-
tions that are provided as inputs to the program. Two Fourier approximations are used
to describe the loading on the pulley. One Fourier series is used to describe the load-
ing in the tangential direction while a second Fourier series is used to approximate the
loading distribution in the axial direction. The advantages of this program include its
ease of use coupled with a short execution time, making it a valuable design tool which
allows the designer to review the effect of a design change on the stress distribution in

a short period of time.
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1.2 Getting Started in PStress

This section gives an overview of how to solve for the stresses in a pulley using PStress,

and how to process the output file to quickly determine if the pulley design is acceptable.

We begin by opening PStress and entering the dimensions of the pulley and shaft, as
well as the forces on the pulley. Open PStress and enter the pulley properties exactly

as they are shown in Figure 1.1.

Note: The PStress input screen supports three languages— English, Spanish, and
Portuguese. To change the default input screen language, select “Preferences” from
the “Edit” menu. This will open the preferences dialog box which allows the user

to set a default language.

¢ PStress V3.23 o [ S
- — -
File Edit Help
Simulate Pulley
Input | g ize Results | Full Result
——IDENTIFICATION— —LOADING INFO— —0DISK GEOMETRY—
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Material: 44 < Material: 14w Material: 4140 HT2SR o Tren=nisshie Torue| 190 n 121
UTS: 443 uTS: 443 uTS: 724 28 11 A 0
¥g: 303 Ys5: 303 ¥5: 566 321 N ]
DISK
Endurance: 62 Endurance: 62 Endurance: 114 cL 601 321
5. 680 A ]
6. 750 250 100
77 250 0
BRG o0 230
g, 851 250 1
| 10. 500 240 o
11. 910 0
Saved... D\Work\AndysCode\P5Stress V3.2.3\5ave File Test\Overland Pulley 1.in

F1GURE 1.1: PStress Input Screen

After entering all the data shown in the Figure 1.1 save the file by selecting ”Save as”
from the “File” menu. Once the file is saved click the “Simulate Pulley” button on the
tool bar just below the file menu. This will run the PStress pulley solver. Two black
windows may or may not flash momentarily on the screen. If the data was correctly

entered, the solution should converge in less than a second. Now click the “Summarize
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Results” tab. If the data was correctly entered, and PStress install properly, you should

see the screen that appears in Figure 1.2. If so, congratulations, PStress was successfully

installed.

5 — — - .
= PStress V3.23 = | |
File Edit Help

Simulate Pulley
Input | S ize Results | Full Result
t t + -
| CLIENT : BBC (Pwt.) | CONVEYOR DYNAMICS, INC. | BAGE NO. : "_
| JOB NUMBER : | 1111 WEST HOLLY ST. BELLINGHAM, WA 9BZZS5 | DATE - OCI—2:1=
| DESIGNER : John Doe | BSTRESS V3.2 : PULLEY STRESSES AMNALYSIS | P
| DESCRIEFTICN : Conveyor Pulley X
| GENERAL REMARFS : orem Epsum
INPUT SPECIFICATIONS
BELT BELT WIDTH, (INCHES) ...ttt i i cecececemmemm e | 47 .24 |
TENSION T1 / POLAR ANGLE, (LBS/DEG) ....-c.ccccececccncnnannn | &789%2. | Q.00 |
TENSION T2 / POLAR ANGLE, (LBS/DEG) ......cceccmemccccncnnan | &783%2. | 2.00 |
RIM DIAMETER, [(ERCHES) - oo cmmommc e miem e m mm i | 43.31 |
TRETCNNENS. $TNEER) oo e L P L e B S S | 0.38 |
DISC THICEMESS AT HUB / FILLET RADIUS, (INCHES) ._._.__._._.__._._.____._.. | 1.57 | 2.01 1
I THICEMESS AT RIM / FILLET RADIUS, (INCHES) .. __..__..__-_--.-.- | 1.18 | o_%8 |
SHAFT DIAMETERS, AT DISC / CENTER, (INCHES) .. ._._.____ . __--_-_----- | 12 .84 | 1z |
CENTER DISTANCES, BEARRING f DISC, (INCHES) ._.___._._.__._._.____._.. | €2.39 | 47._.32 |
HUB DIAMETERS, INNER /7 OUTER, (INCHES) .__.__.____________--__---.- | 15.34 | 23.88 |
WIDTH,: (EEEHES): oo sdsime Lo die b bl b L desn il ol S i it ) | €.30 |
. LOCE DEV WIDTH, (INCHES) ... o i i e amecamcmmmmmmmmmemmeman | 4.33 |
NOMINAL LOCKING PRESSURES, SHARFT f HUB , (PSI) ............. | 15084. | 9718. |
NOMINAL M2X TRANSMI IELE TORQUE, (FI-LB) ...-c-cococooooo.- | 140137, |
CONTACT PRESSURE MULTIPLIER / DEVICE TYPE ... .. .. _------.- | 1.000 | SHORT |
CUTPUT SPECIFICATIONS
GENERAL WERAD RNGLE, ) =3 182 .00 | -
4 m 3

Opened: D:\Work\AndysCode\P5Stress V3.2.3\5ave File Test\Overland Pulley 1.in

FIGURE 1.2: PStress Results Summary Screen

In the current version of PStress, the data on the summary page is always scaled to
English units. However, much of this sheet can be converted to metric units using a

spreadsheet provided in your PStress installation.

Before converting the summary file it must be saved to your hardrive. Selected the
“Save” option from the “File” menu to ensure that all the simulation results are saved.
Next, from the Windows “Start” menu select the “CDI” folder and open the “Goodman
Diagrams” Excel spreadsheet. The spreadsheet shown in Figure 1.3 should appear. Note:
to use this spreadsheet you must enable macros. If you do not see the green button shown
in Figure 1.3 make sure the work sheet you are displaying is “Pulley Stresses” and scroll

to the top right.

To load the summary data into the excel spreadsheet click the green button. Navi-
gate to the folder where the pulley data was saved and select the filename with the
“-summary.out” appended to the end. The speadsheet should load the summary of the

pulley results and convert the stresses to metric units. It will also plot the oscillating
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FI1GURE 1.3: PStress Postprocessing

stresses in the critical area of the pulley in Goodman Diagrams found on the “Pulley

GD” worksheet.

This concludes our brief overview of the PStress software. A deeper review of the input

data required by and the output data produced by this software appears in successive

chapters.
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Defining a Pulley in PStress

2.1 Pulley Shape

PStress is designed to compute the stresses in CEMA “Engineered Class” pulleys with

T-Section end disks like the one shown in Figure 2.1

Dist. Weld to Disk

NN N

i)

y
A

F1GURE 2.1: PStress Pulley Schematic
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PStress assumes that the end disk is symmetrical. It also assumes that the fillet radii
end tangent to the horizontal. If the fillet between the hub and the end disk is not
tangent to the horizontal where the end disk meets the hub than the shape of the fillet
will need to be manually defined using multiple points in the “Disk Geometry” section.
PStress will interpolate between disk thickness values using a power function. Note: to
define multiple points in the “Disk Geometry” section the “# Radial pts (<10)” value

must be incremented in the “Disk” section.

2.2 Material Properties

The default materials known to PStress are listed in the materials.tzt file found in the
PStress installation folder. This file is a text file which the user can edit to add additional

materials.

The Ultimate Tensile Stength and the Yield Strength of the materials in a pulley are
usually easy to find. However, the endurance limit is not usually listed in suppliers
tables. The PStress solver does not use endurance limit to compute the stresses in the
pulley. However, this number is used by PStress to predict the onset of fatigue. CDI

recommends using the following endurance limits, S., when evaluating pulleys:

Disk and Hub
The endurance limit strength is +24% of yield strength in base metal and +18%

of yield strength in welded zones.

Rim
The endurance limit strength is +£15% of yield strength (note, there is a butt
weld across the entire face of the pulley which will rotate through all high stress

regions).

2.3 Shaft Geometry

The shape of the pulley shaft is defined by the table in the lower right hand corner of the
“Input” tab. “Axial Length” is the distance from the center of the shell to the feature
being defined. The 4th row of the table always specifies the location of the pulley end
disk. The 8th row always specifies the location of the bearing. Turndown “fillet radius”
end at the dimension specified in the axial length column. An illustration of the shaft

dimension locations appears in Figure 2.2.
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FIGURE 2.2: PStress Shaft Schematic
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Interpreting PStress Results

3.1 PStress Output Summary

The PStress output summary contains the following results of the pulley stress analysis:

1.

2.

Input Specifications
Output Specifications

(a) Wrap Angle
(b) Total Bear Load
(¢) Total Torque
(d) Bending Moment
e) Locking Device Slip Check
0

(
(

Stiffness of the various pulley components

. For each End Disk, Hub, Locking Device, Rim, Rim (center), Disk-Rim Weld:

Principal Stresses

Locations of largest range of principle stresses, and the max and min stress at

these locations (used in fatigue analysis)

. Shaft (at each of the 11 locations specified in the input file):

8
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Bending Moment
Torque

Transverse Force

Shear Stress
Transverse Shear

)
)
)
(d) Bending Stress
)
)
) Max Shear
)

Max Von-Mises Stress

The stresses are tabulated for both sides of the pulley component surfaces. In PStress
the “Inside” column refers to the interior of the pulley, and the “Outside” column refers

to the exterior of the pulley. In the summary file, the following nomenclature is used:

SIGMAR: Radial stresses

SIGMAP: Tangtial stresses

SIGMAZ: Axial stress

TAURP: Shear stress (hub, Disk, locking device)

TAUZP: Shear stress (Rim)

3.2 Fatigue Analysis using a Goodman Diagram

As the pulley rotates, the rim and the disk are subject to fluactuating stresses which
can cause high-cycle fatigue failure in these parts. The Goodman diagram is used to
determine is the various parts of the pulley will fatigue to failure. This diagram is shown

in Figure 3.1. To use this diagram we define the following parameters:

Omin, = minimum stress

Omar = mMaximum stress

Oq = stress amplitude = (0maz — Omin)/2
Om = stress mean = (Opmaz + Omin)/2

The Goodman Diagram shows all the strengths and limiting values of the stress compo-

nents for a particular mean stress. Failure is defined by the heavy outline.

The endurance limit strength, Se, is the point at which fatigue failure will not occur

regardless of the number of cycles of loading applied to the part. The value of S, is a
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Su

Sy

Se

Stress

FIGURE 3.1: Goodman Diagram

function of material properties (discussed in the previous chapter), the manufacturing

processes, the operating environment, and the design of the part.

In addition to the fatigue stress checks, CDI recommends adopting the following maxi-

mum stress limits:

Disk and Hub

The maximum combined stress should not exceed 70% of yield.
Rim

The maximum combined stress should not exceed 50% of yield.
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